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• Take 5 Minutes

• Turn to a Person Near You
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Let Rego be your guide. 
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Introductions



Part I: 
Introduction

Let Rego be your guide. 
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• Full bidirectional connection between CA PPM and MSP

• Stop relying on multiple spreadsheets and applications for data

• Real-time progress updates on MSP project schedule through CA PPM 
Timesheets

• Repeatable processes and centralized data are essential in providing 
accurate reports and actionable metrics

• MSP is an industry standard and widely used by most Project Managers

Let Rego be your guide.
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Why Integrate MSP with CA PPM?



Projects

Let Rego be your guide. 
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Open A Project Schedule

Let Rego be your guide.
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Choose “Open” from the CA PPM Integration menu:

You may be asked to login to CA PPM*

Choose the project from the “Open from Clarity” 
selection box

Choose either (Read-Write) or (Read-Only) from 
the Project > Properties or Tasks tab:

The CA PPM “Scheduler Format” in Project > 
Properties needs to be set to “Microsoft Project”

From MSP…From CA PPM…



When opening a project schedule from CA PPM to MSP, the following occurs:
• If the project was previously saved from MSP to CA PPM, the latest “.mpp” file 

from the CA PPM database is downloaded and will overwrite/copy the “.mpp” file 
to the local drive 

• The MSP schedule will then be updated with any data changes that were made 
directly in CA PPM since the “.mpp” file was last saved.  
• Actuals Posted from Timesheets
• Task Level Updates
• Project Team Updates 
• Resource Assignment Updates

Let Rego be your guide.
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Open A Project Schedule – Legacy Driver



When opening a project schedule from CA PPM to MSP, the following occurs:
• If the project was previously saved from MSP to CA PPM, the saved “XML” file 

from the CA PPM database is downloaded and then updated with any data 
changes that were made directly in CA PPM since the last save
• Actuals Posted from Timesheets
• Task Level Updates
• Project Team Updates 
• Resource Assignment Updates

• The XML is then opened and a new MPP is generated in your default save 
location along with the new XML file that was created

Let Rego be your guide.
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Open A Project Schedule – XML Driver



The “Save” button will save your MSP Project Schedule back to CA PPM:

When an MSP schedule is saved to CA PPM, with the Legacy Driver the MPP 
is saved in the DB.  If using the XML driver a zip of the mpp and XML is saved 
to the CA PPM database where all unmapped fields and global settings are 
preserved

Let Rego be your guide.
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Save A Project Schedule



The “Save As” button will allow you to:

• Save copies of existing CA PPM Projects as New Projects in CA PPM (Save As)

• Save new projects to CA PPM from MSP (Save As)

Note:  The NEW XML version of the MSP Interface will NOT allow you to use 
“Save As” to save a schedule over an existing CA PPM project

Let Rego be your guide.
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Save A Project Schedule



All Task and Assignment data in MSP is saved back to CA PPM, EXCEPT:

• New Charge Codes
• Actual Hours (if track mode is set to PPM)
• Unplanned Tasks and Assignments – Tasks with hours, but no resource 

assignment
• Manual edits to the Baseline

Let Rego be your guide.
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What Data Is Saved From MSP To CA PPM



• If you would like to work on the project schedule offline or disconnected from CA PPM, 
you can:
• Open the Project from CA PPM to MSP

in Read/Write mode
• From the MSP file menu, click

File > Save As and select a location on
your local hard drive

• Exit out of MSP

• You can now work on the project schedule that was saved to your local drive
• CA PPM will maintain a lock on the project until it is successfully saved back to CA PPM

• When you’re ready to save it back to CA PPM, open the file and click on “Save” under 
the CA PPM Integration Toolbar 
• You may need to log back into CA PPM

Let Rego be your guide.
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MSP Working Copies



• The Master Project should be created as a “shell” in CA PPM.  Do not add 
staff to the Project Team, create tasks or track actuals in the Master Project

• Create or identify the Sub-Projects and add them to the Master Project 
from Project > Properties > Subprojects

• Add many subprojects to a master project  - MSP have a 50 project limit –
master and 49 subs

Let Rego be your guide.
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Master And Subprojects



• When a Master Project is opened from CA PPM to MSP, all related sub-projects 
are also opened – up to 49

• Resources from all sub-projects are merged and added to the Master Project’s 
resource sheet in MSP, but are not copied back to CA PPM when saved

• If there are no assignments for a particular team member, they are removed 
from the sub-project’s team when saved to CA PPM

• Sub-Project schedules can be opened and worked on independently

Let Rego be your guide. 
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Master Projects in MSP



Baselines can be created in either CA PPM or in MSP

• CA PPM supports unlimited baselines
• MSP supports 11 baselines

In MSP, go to Tools > Tracking > Save Baseline
In CA PPM, go to Projects > Properties > Baseline     

Let Rego be your guide.
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Baselines



Cost Information in MSP is retrieved from the Financial Cost Matrix in CA 
PPM.   Cost rates determine the cost that is associated with a resource 
assigned to a task

Costs are shown over time by Task and at the Project Level

Any changes that are made to cost rates directly in MSP are for “What-if” 
purposes only and WILL NOT be saved back to CA PPM

Let Rego be your guide.
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Cost Data



Resources

Let Rego be your guide. 
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Resources should be staffed to the project in CA PPM before the project 
schedule is opened in MSP

Resource and Calendar Data should be updated and maintained in CA PPM.  
Changes made in MSP will not be copied back to CA PPM.  This does not 
apply to Resource Assignment information on Tasks.

Let Rego be your guide.
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Resources



Allocation (CA PPM) – the expected amount of time that a resource is 
expected to work on the project

Max Units (MSP) – the maximum percentage of working time that a resource 
is available to work on project tasks

Assignment Units (MSP) – the percentage of working time that a resource is 
assigned to work on that one task

Let Rego be your guide. 
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Allocation, Max Units and Assignment Units



Let Rego be your guide.
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Max Units

• Average Allocation % and Allocation Hours from CA PPM Team Page:

⎻ MSP Resource Sheet – Max Units:

⎻ The 36% comes from the Allocation % Segment that matches the current date

⎻ In CA PPM, it’s displayed to the 
hundredths, but is
rounded to a whole number in MSP



In previous CA PPM versions, the Task Assignment Unit % would get over-
written with the Allocation %

To prevent this from happening, your CA PPM Administrator can check the 
following option from:

Administration > Project Management > Settings:

Let Rego be your guide.
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Assignment Units



• When Tasks are created and resources are assigned, the Assignment Units for each 
resource is defaulted from their Max Units
• The two tasks below were entered with 40 hours of work and then assigned to each 

resource
• Since Jerry’s Assignment Units is 100% on a 40 Work Hour task, the Task Duration was 

calculated to be 5 days
• Since Lisa’s Assignment Units is 36% on a 40 Work Hour task, the Task Duration was 

calculated to be 14 days

Let Rego be your guide.
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Assignment Units

Note:  The Assignment Units for a resource on a task can be 
changed when assigning the resource to the task. This will 
not change the Max Units



• Resource Leveling in MSP is the process of delaying or splitting a resource’s work on a 
task to resolve over-allocation

• Level Resource – resolves conflicts for the selected Resources only
• Level All – resolves conflicts for the entire project

Note: The results of Resource Leveling may be significant on a project schedule, but resource leveling 
does not change who is assigned to tasks, the total work or Assignment Unit values

Let Rego be your guide.
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Resource Leveling



Tasks

Let Rego be your guide. 
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Let Rego be your guide. 
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CA PPM vs. MSP Terminology

CA PPM MSP
Total Usage Work
ETC Remaining Work
Actuals Actual Work
Project Team Allocation % Max Units
Max % Load Assignment Units



• Do Not Assign Resources to a Summary Task – This is allowed in MSP, but 
not in CA PPM.  You will get the “Summary Task Assignments are not 
Supported” error

• Do Not put ETC/Remaining Work on a Milestone – The milestone will turn 
into a task the next time the schedule is opened from CA PPM to MSP

• Do Not put Actual Hours on a Milestone – If hours are added to a 
Milestone without a Resource Assignment, the Actual Hours will stay on 
the Milestone in MSP.  If hours are added to a Milestone with a Resource 
Assignment, the Hours won’t stay in MSP after a save to CA PPM

Let Rego be your guide.
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MSP Task “Don’ts”



• MSP uses the following scheduling formula when calculating tasks:
• Work = Duration x Assignment Units

• Each value of the formula corresponds to a Task Type:
• Fixed Work
• Fixed Duration
• Fixed Units 

• Which task type should be used? 
• It depends on the processes in the organization

Let Rego be your guide.
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Task Types



• If work hours are used to estimate how long deliverables will take on a 
project based on resource assignment
• All Fixed Work tasks are Effort Driven

Example:
• Team Leads will look at project requirements and provide an estimate in hours for 

each project deliverable
• Project Managers will estimate how many hours each deliverable will take based on 

experience or a project sizing tool

Let Rego be your guide.
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Fixed Work



• If Duration (number of days) is used to estimate how many hours 
deliverables will take to complete based on resource assignment

Example:
• Team Leads will provide the estimated number of days or weeks that deliverables 

will take to complete
• Project Managers will estimate how many days each deliverable will take based on 

experience or a project sizing tool

Let Rego be your guide.
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Fixed Duration



• If resources are managed and allocated to projects based on a percentage 
of their time or if projects are estimated based on the number of resources 
needed in each role, then “Fixed Units” would work

Example: 
• “Resource A” is assigned to a project for 100% of their time to work on tasks. It’s the 

Resource Manager’s responsibility to make sure they are adequately utilized
• Projects are estimated and staffed with one Project Manager, two Business Analysts, 

four Software Engineers, etc.

Let Rego be your guide.
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Fixed Unit



Let Rego be your guide.
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Loading Pattern / Work Contour

CA PPM calls it a “Loading Pattern”…
MSP calls it “Work Contour”…

Whatever terminology is used, they both mean the same thing...
It dictates how resource work hours are scheduled over time

CA PPM’s “Loading Pattern” field maps to MSP’s “Work Contour” field



• Recommended Default Load Pattern is “Uniform”
• CA PPM Administrator can set the default from: Administration > Project 

Management > Settings:

• The reasons for this recommendation:
• Due to the way Microsoft Project distributes estimate to complete (ETC) 

when using both front and back contour patterns, and
• Performance when opening from and saving to CA PPM SaaS – when using 

the Legacy Driver
Let Rego be your guide.
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Loading Pattern / Work Contour



Loading Pattern / Work Contour

Let Rego be your guide.

34

If you first create the task assignment in Microsoft Project:
Work Contour in 
Microsoft Project

Loading Pattern in
CA Clarity PPM

Flat becomes Uniform
Front becomes Front
Back becomes Back

The msp specific work 
contour designated on 

the task when it was first 
created in MSP. (Turtle, 

Bell, etc…) becomes Contour



• Fixed Loading Pattern – remaining ETC gets dropped if someone charges less 
hours than what was planned.  It will affect the forecast

• Project Templates will use the Loading Pattern from when the Template was 
created.  The default Loading Pattern needs to be set before creating the 
template….

Let Rego be your guide.
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Loading Pattern / Work Contour



Effort Driven Scheduling

Let Rego be your guide.
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Effort Driven scheduling ONLY applies AFTER the initial resource assignment is made, even if you initially
add more than one resource

Assign an additional resource at 100% to the tasks

Note:  “Fixed Work” will force the task to be “Effort Driven”, so if “Fixed Work” is chosen 
as the default, all tasks will automatically be “Effort Driven”



• All “automatically” scheduled tasks will have an “As soon as possible” constraint
• If tasks are created in CA PPM or copied from a template and the Task Start Date is not 

the same as the Project Start Date, MSP will place a “Start No Earlier” constraint on the 
Task when the Project Schedule is first opened from CA PPM to MSP
• This applies to the Legacy Driver ONLY; no constraints will be applied using the new XML 

driver

Let Rego be your guide. 
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Task Constraints

Constraint Types
As Late As Possible Forces a task to start on a date in order for it to finish before 

the end of the project

Finish No Earlier Than/Finish No Later Than Sets the completion of the task to fall no sooner or no later 
than the specified date

Must Finish On/Must Start On Forces a task to Finish or Start on the specified date

Start No Earlier Than/Start No Later Than Sets the start of the task to fall no sooner or later than the 
specified date



• Milestones are a point in time and do not have a duration or work assigned 
to them

• In MSP, you can identify a Task as a Milestone from Task Information > 
Advanced or by adding the Milestone field column in one of the MSP task 
views

• Milestones can be linked to other tasks/milestones
• Resource(s) can be assigned to a Milestone
• DO NOT enter a Duration or Work on a Milestone

Let Rego be your guide.
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Milestones



• Duration can be entered in MSP as Working Days or Elapsed (Calendar) 
Days, which is the amount of time that a task should take to finish based on 
a 7 day / 24 hour schedule, including holidays and non-working time

• In MSP, the Duration can be entered as “3ed” to reflect Elapsed Duration 
instead of “3d”

• The NEW XML driver with MSP 2010 or later will retain the Elapsed 
Duration

• The Legacy COM driver DOES NOT retain the values from MSP to CA PPM 
and will be converted to Working Days in CA PPM

Let Rego be your guide.
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Elapsed Duration



How do Actuals 
Affect Project Schedules?

Let Rego be your guide. 

40



1. Resources assigned to tasks will submit their hours through CA PPM Timesheets

2. Timesheets will get Approved and then Posted

3. When a timesheet is Posted, the ETC field is modified on any task assignment that 
has Actuals

Note:  If the task assignment has Loading Pattern/Work Contour of Fixed in CA PPM or 
Contoured in MSP, planned ETC that WAS NOT submitted as Actuals by that 
Resource will be removed, which may decrease the Total Work (Effort) on that 
task

Let Rego be your guide.
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How do Actuals Affect Project Schedules?

Three (3) Ways:



• Loading Patterns/Work Contours are set to “Contoured” in MSP if 

Assignment Hours are modified through the Resource Usage View

• If a Resource submits a timesheet without any hours charged to a 

particular task that was assigned to them with ETC for that week, those 

hours will get pushed out and redistributed throughout the remaining 

duration on that task or dropped depending on the Loading Pattern/Work 

Contour

• Actuals posted to one task may affect the dates of another task if they are 

dependent on one another

Let Rego be your guide.
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How do Actuals Affect Project Schedules?



• Resource submitted their timesheet with the same number of hours 
assigned:

• Assigned Hours vs. Actual Hours:

• Results:

Let Rego be your guide.
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Actuals: Same Number of Hours as Planned

Thu
1/23

Fri
1/24

Mon
1/27

Tue
1/28

Wed
1/29

Thu
1/30

Assigned Hours 8 8 8 8 8

Hours Entered
on Timesheet 8 8



• Resource submitted their timesheet with FEWER hours than assigned

• Assigned Hours vs. Actual Hours:

• Results: Since only 4 of the 8 hours that were assigned were recorded, the 
duration increased by .5 days for both the Fixed Units and Fixed Work Task 
Types

Let Rego be your guide.
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Actuals: Fewer Hours than Planned

Thu
1/23

Fri
1/24

Mon
1/27

Tue
1/28

Wed
1/29

Thu
1/30

Assigned Hours 8 8 8 8 8

Hours Entered
on Timesheet 8 8 4



• The Fixed Duration task didn’t change the duration, but distributed the 
additional 4 hours over the last two days so Work is now 10 hours for 
Tuesday and Wednesday

Let Rego be your guide.
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Actuals: Fewer Hours than Planned (cont’d)



• Resource submitted their timesheet with MORE hours than assigned

• Assigned Hours vs. Actual Hours:

• Results: The Fixed Units and Fixed Work task Durations went back down to 5 days since 
the resource “caught” up

Let Rego be your guide.
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Actuals: More Hours than Planned

Thu
1/23

Fri
1/24

Mon
1/27

Tue
1/28

Wed
1/29

Thu
1/30

Assigned Hours 8 8 8 8 8

Hours Entered
on Timesheet 8 8 4 12



• The Fixed Duration assigned hours for Wednesday went back down to 8 
hours since the resource submitted additional hours the day before

Let Rego be your guide.
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Actuals: More Hours than Planned (cont’d)



• Resource skipped the last day of assigned work and then entered fewer hours on the 
day after the task was supposed to finish

• Assigned Hours vs. Actual Hours:

• Results: Since zero hours were recorded on Wednesday, the task gets split
• Fixed Units and Fixed Work task types will calculate Duration without counting the days in between 

the split
• Fixed Duration tasks WILL count the days in the middle of the split

Let Rego be your guide.
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Actuals: Skipped a Planned Day

Thu
1/23

Fri
1/24

Mon
1/27

Tue
1/28

Wed
1/29

Thu
1/30

Fri
1/31

Assigned Hours 8 8 8 8 8
Hours Entered
on Timesheet 8 8 4 12 0 4



• The Task Finish Dates all changed to Friday, 1/31, to accommodate the 
extra 4 hours needed to complete the task

Let Rego be your guide.
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Actuals: Skipped a Planned Day (cont’d)



One of the biggest complaints from Project Managers is that CA PPM changed their 
MSP task dates in their project schedule

• When many task dates change, it’s difficult for the PM to find the root cause

• By default, Task Start and Finish Dates are already mapped between CA PPM and 
MSP
⎻ Those dates may change as Actuals are applied to the project schedule

• You can extend the mapping table with the following MSP fields to make it easier:
Start10 prStart
Finish10 prFinish

Let Rego be your guide.
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Prior Start And Prior Finish Fields



• The extended mapping should NOT be bi-directional; it should be on 
“Export from CA PPM” only

• When a project schedule is exported from CA PPM to MSP, the Task Start 
and Finish Dates will be copied to both the MSP Start and Finish fields as 
well as the new Start10 and Finish10 fields

• The Actuals are then applied to the schedule which may cause the original 
Task Start and Finish Dates to change, but not the new Start10 and Finish10 
fields

Let Rego be your guide.
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Prior Start and Prior Finish Fields



• The Project Manager is now able to compare the following fields to find the 
first task with a difference

Start >> Prior Start
Finish >> Prior Finish

• You can then look at that task and any predecessors to see what could have  
caused the dates to change

Let Rego be your guide.
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Prior Start And Prior Finish Fields



• You can extend the mapping table by adding the “Open for Time Entry” 
(Flag11) field so Project Managers can better control what tasks are open 
for time entry from MSP

• This should be a bidirectional mapping so the data flows from CA PPM to 
MSP and from MSP to CA PPM

• In CA PPM, the Open for Time Entry field defaults to “Yes” for new tasks 
and in MSP it defaults to “No” for new tasks

Let Rego be your guide.
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Open For Time Entry Field



Maintaining 
the Project Schedule

Let Rego be your guide. 
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Once a resource charges time to a project and those hours are posted as Actuals, 

the Project Manager needs to frequently maintain the project schedule:

• Step 1: Open the Project Schedule from CA PPM to MSP

• Step 2: Review new Actual Work Hours to ensure they look accurate

• Step 3: For Tasks that are Complete:

Verify that the Remaining Work field is zero (0)

• If there are hours, enter zero (0), which will reduce the Work field so it matches the Actual Work 

field

1. Enter “100%” in the “% Complete” field

2. Mark the task as “Not Open for Time Entry”

Let Rego be your guide. 
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Maintaining the Project Schedule



Let Rego be your guide.
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Maintaining The Project Schedule

Step 3 – For Tasks that are Complete, cont.
• To “Close” this Task:

• Work was planned to take 40 hours, but the task was completed with 16 
hours:

• Right Way
Enter “0” for Remaining Work
Enter “100” for % Complete

• Wrong Way
Enter “100” for % Complete



Step 4: For Tasks that are still in progress:

• Adjust any Work hours that need to be increased
• Verify that all tasks have values in the Remaining Work field
• Reschedule any task with a “Finish Date” in the past
• Reschedule any task with a “Start Date” in the past that hasn’t started yet

Let Rego be your guide. 
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Maintaining the Project Schedule



Copy a Task:
You CAN use copy/paste to create a NEW Task 
• New IDs will be given to the copied task

Move a Task:
Use the Drag and Drop functionality to move a task
DO NOT use cut/paste to move a task in the project schedule
• This will change the unique Task ID that is used by the CA PPM – MSP Integration

Let Rego be your guide.
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Copy Or Move A Task



Custom Fields can be easily mapped between CA PPM and MSP from CA 
PPM – Administration > Project Management > MSP Field Mappings*:

Let Rego be your guide.
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Custom Field Mapping



Let Rego be your guide. 
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Questions?



Instructions for PMI credits 
• Access your account at pmi.org
• Click on Certifications
• Click on Maintain My Certification
• Click on Visit CCR’s button under the Report PDU’s
• Click on Report PDU’s
• Click on Course or Training
• Class Name = regoUniversity
• Course Number = Session Number
• Date Started = Today’s Date
• Date Completed = Today’s Date
• Hours Completed = 1 PDU per hour of class time
• Training classes = Technical
• Click on I agree and Submit

Let Rego be your guide. 
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Thank You For Attending regoUniversity

Phone
888.813.0444

Email
info@regouniversity.com

Website
www.regouniversity.com

Let us know how we can improve! 
Don’t forget to fill out the class survey.

mailto:info@regoconsulting.com
http://www.regoconsulting.com/

